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UTTAR PRADESH POWER CORPORATION LTD.

[Participant 1D
Participant Name

Test Center Name

Test Date 22/11/2022

Test Time 9:00 AM - 12:00 PM
Subject [Executive Assistant

Section : Computer Knowledge - CCC Level

Q.1 THTH-TRT (MS-Excel) 365 H Ageayul T (de) &Y fAgerd U & grgaige o34 &
1T, AR, FER 3R AP T ITANTT FIP STeT A ¢8f B M F Ugar & e
fFrafafaa o | fea fawe o1 3ua faar sirar 82

Ans X A Id WEA (Cell Styles)
X B. Bl¥c U o9 (Format as Table)
o C. BT W (Conditional Formatting)
X D. fUge <9 (Pivot Table)

Question ID : 8401606402
Status : Answered
Chosen Option: C

Q.2 IS Rew @t gfew uferar & a1 welkia g arelt ugeh i Fufefea & @ &= W @2
Ans X A T IR (Status bar)

X B. TR (Menu bar)
o C. S&hcly (Desktop)

25 D. 3P (Icon)

Question ID : 8401606420
Status : Answered
Chosen Option : B
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Q.3 THTH-TS (MS-Word) 365 ¥ IaaTferd gai€ (bullets) 3R HafAT (numbering) F1 3 H3A
P16 4 Fafif@a A F s ar g2

1. 3P e AT (AutoCorrect Options) &1 T PIfoIg, 3R Eﬂﬁﬁlﬁ 3ffcIprae ﬁT:[
ol <IgU (AutoFormat As You Type)’ 9 P19 FifvTI

2. BI3d R 9T¢ > T==A > Yfb (File > Options > Proofing)

3. Select OK &1 T4 BIfoQ|

4. TR gaes fored a1 SiferAfe® Had foReH (Automatic bulleted lists or
Automatic numbered lists) T A PHIFIT a1 TR Bifo]

Ans X A 1,234
X B.2,4,1,3
X C.2,1,3,4

& D.2,1,43

Question ID : 8401606414
Status : Answered
Chosen Option : B

Q4 A9 fRram ¥ wef A Fufofad & 3 o9 w1 v34 s/ 82
Ans 2 A BHTO BIE B IS ¥ e Td (TsH) T SIS Uhd & |
X B.8H'Bec IS ! WMol B1s IHhd &
X C.BH 'Cc Bits & TTel Bl Iohd gl
X D. To’ 3R ‘Cc’ HITs 3RR UH GUR & VM W ITIN fHT 91 §

Question ID : 8401606389
Status : Answered
Chosen Option : C

Q5 Fofifed & $1 o e Rty o ek wiwed 82
Ans g2 A R Rren (Payroll system)

X B. [fMa9 (Linux)

X c. [f8 (Windows)

X D. Sead Jwic ey (Database management system)

Question ID : 8401606430
Status : Answered
Chosen Option : B

Q6 wmmmm*mmﬁammmmmm
?

Ans X A THTYH-URN (MS-Access)
«” B. THUH-UGRUISC (MS-PowerPoint)
2 C. THUY-a8 (MS-Word)

X D. THUY-TRIA (MS-Excel)

Question ID : 8401606391
Status : Answered
Chosen Option : A
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P P fore Faferfad # @ 59 yeR & Y63 &1 IuahT fawar simar 82
* A H-J

X B.HJ
75 C. $H$J
o D.HJ

Ans

Q7 THUH-UTR (MS-Excel) 365 & BT § HIAH (columns) H & J a% |3t a1 31 Hehifa

Question ID : 8401606405
Status : Answered
Chosen Option : A

¥ fore Frafafad & @ e SIS widee o1 IuahT fear srar 22
X AF2
o B.F5
X C.F4
X D.F9

Ans

Q.8 THTH-UTGRUISE (MS-PowerPoint) 365 H Tgd! T3S A IATSS M (slide show) IR B

Question ID : 8401606395
Status : Answered
Chosen Option : A

Q.9 THTH-TRIT (MS-Excel) 365 ¥ frafafea & & frw 3a o ab=iic # gferee ufdal
(rows) P geH (remove) &I fape '@Tﬂ %?

& A (View)
/< B. W‘I"{T’I‘W (Formulas)

& C. SIcl (Data)
X D. R (Review)

Ans

Question ID : 8401606404
Status : Answered
Chosen Option : D

H A B | BIaR ST 99 {51 &1 9 32
o A WQ@TW (Programs and Features)

X B. fgarzy 3R fiicH (Devices and Printers)
X C. &3y AR (Device Manager)
X D. f&wiee IR (Default Programs)

Ans

Q.10 f¥SIT 11 (Windows 11) TR WITH &t 3S¥ed 91 A B & g dgta e & Fafafea

Question ID : 8401606421
Status : Answered
Chosen Option : A
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Q.1 fgfafEd d | $19 91 fISie cRpaR o1 fay Ae=E § ol IpuSs § Ta 3¢ W iR
msﬁvﬁiﬁ%ﬁﬁﬁrkm'—r ge¥Ae AR 31 R 3R Fie aiegy daa At TSR
weRfq war 82

Ans XA %W(Menu icon)
X B. ®TE T (Start menu)
X . fag® @ SR (Quick launch bar)
o D. Afefrarzr wfear (Notification area)

Question ID : 8401606422
Status : Answered
Chosen Option : B

Q.12 "®PIFRITE’ (Screenshot) fAHeT THTH-IE 2010 (MS-Word 2010) & ok |
Iuas g

Ans X A BIH (Home)
X B. R (Review)
« C. 3 (Insert)
X D. f&SIEH (Design)

Question ID : 8401606412
Status : Answered
Chosen Option : A

Q.13 ﬁaﬁﬂ@aﬁﬁﬁﬂmwaﬁmﬂﬁ% R gRT &9 A9 ST d% g9 IPd § iR
ITHT SUUNT H THA 27

Ans A TSR (Pager)
X B. 30 FAISH (Email clients)
< C. Hia1Sd W9 (Mobile phone)
X D. 398d (Webmail)

Question ID : 8401606387
Status : Answered
Chosen Option : B

Q.14 fgfafaa ® A f5 SifRex &1 I fHar o1 T&ar 8, 99 g9 T (Google) TH §o1-1 &
Tt ke wreg 3R 5w wreg & forg 1S W wreg @i =med 82

Ans X A U g (Minus)
X B. UIRTS (Period)
& C. I8 (Tilde)
< D. I 2% (Quotations)

Question ID : 8401606434
Status : Answered
Chosen Option : A
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Q.15 HTFPHIEITE TS (Microsoft Edge), 3TURT (Opera)3iR Twel FHR (Apple Safari) ¥
ISTERUI &1
Ans X A 99 UG (web page)

« B. 39 STITR (web browser)
X c.ag T (web server)
X D. Id M (search engine)

Question ID : 8401606418
Status : Answered
Chosen Option : D

Q.16 Hugex Hi-eR HY VDU i ST SITaT 8 IVDU TS HT UF 7 F1 82
Ans 2 A Video Display Unit (dIf$a fset gfe)

2 B. Vertical Dialysis Unit (aféea SrafeaiR/ gfie)

X C. Vertical Display Unit (@¢&d fe¥a gfe)

2 D. Video Dialysis Unit (dif&a) STafei gf-ie)

Question ID : 8401606429
Status : Answered
Chosen Option : C

Q.17 FafafEd & @ #1991 e gRird airaw 78 82
Ans X A USGRRY

X B. & SR

X C. Hd BR

o D.Alcts

Question ID : 8401606431
Status : Answered
Chosen Option : A

Q.18 Frufifad § @ SI9 IT1 ISPs GRTUGH $ &I aTel Jar 781 82
Ans X A SHIT-30 9

X B. 3cc TaHE

X C. TS o8 TRy

 D. ST Aeie

Question ID : 8401606419
Status : Answered
Chosen Option : B
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Q.19 frafifed & & $19 @ §exie gR1 waH 3 9 ared HaR dar 32
Ans X A BISd B PICICA! (File Transfer Protocol)

X B. TR (Gopher)

X C. 3mdf (Archie)

o D. 30T (E-mail)

Question ID : 8401606417
Status : Answered
Chosen Option : D

Q.20 g3 TR A & Frafafaa & ¥ feaer Suah vk ar fie)-wfifes a9 39 8
(Home), 3¢ (Insert) 3R fEAIZ (Design) TRgd B & fore favan sirar 82

Ans X' A ¥R IR (Ruler Bar)
X B.TI3cd §R (Title Bar)
X C. WY TR (Status Bar)
& D. BLdR (Menu Bar)

Question ID : 8401606407
Status : Answered
Chosen Option : B

Q.21 fafqy wo=arail &1 g B B IUANT & (flexibility) FEE BT Sifiemgformarn
o1 U Hear 31

Ans X A HHSdI (diligence)
X B. T (speed)
5 C. Y&dl (accuracy)
« D. RS (versatility)

Question ID : 8401606428
Status : Answered
Chosen Option: C

Q.22 THUH-UTRYUTSE (MS-PowerPoint) 365 T3S H &1 fife #vd wwa Frafafea # & s
fife damse &1 ar= fawey 7€ 82

Ans X A 5o U9 WISSH (Full Page Slides)
< B. FIcd UoI¥ (Notes Pages)
o’ C. 37-70I= (Inline)
X D. 33Ta@1ET (Outline)

Question ID : 8401606396
Status : Answered
Chosen Option : C
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Q.23 THTH-TRT (MS-Excel) 365 & faferf@d # @ f6q 29 o A Srellg-H¢ (cell alignment)
faeq 9R- 2Ty SrarsH, fUfse warsa snfe =nfia 82

Ans X' A. 3T (Draw)

& B. B (Home)
5 C. SIel (Data)
7 D. $T¢ (Insert)

Question ID : 8401606401
Status : Answered
Chosen Option : D

Q.24 ?ﬁ@aﬁﬁﬁqmmaﬁqﬁﬁﬁwﬁaﬁmmﬁmaﬁv%aﬁ@?m
2

Ans X A e BRI (Tertiary memory)
2 B. YeTg® BT (Auxiliary memory)
o C. i JaRT (Primary memory)
X D. fgdia® 38R (Secondary memory)

Question ID : 8401606426
Status : Answered
Chosen Option: C

Q.25 THUH-UTGRYUIEE (MS-PowerPoint) 365 H fRafefad & & &= w1 fawed g fAfdy w3
TR e A Fear & ¥ onTelt wargs & R it & g1 @ g wargs e
R dP o (view) H T M2

Ans 2 A TSTY WSS (Advance Slide)
X B. TSaS TUMAHTH (Advanced Animation)
X C. 3hde AT (Effect Options)

X D. SX-M (Duration)

Question ID : 8401606393
Status : Answered
Chosen Option : B

Q.26 TUTH-TRIT (MS-Excel) 365 ¥ fFafafeaa o & &9 a1 9 ts sre1 W9 & smgea &
ATPR F G P 7T UG fFar wrar 8, S TP S (column) T UfERT (row) &
FafRId STeT & Mgy b AN & JHUT ghar 82

Ans g A T (Pie)
 B. W= (Line)
X C.TheR (Scatter)
25 D.dR (Bar)

Question ID : 8401606406
Status : Answered
Chosen Option : A
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Q.27 fPrafaf@d & ¥ 919 91 39 A4 (web mail) TS T8 22
Ans A TS (upGrad)

75 B. TTg (Yahoo)

< C. 313cgP (Outlook)

75 D. T[T (Google)

Question ID : 8401606388
Status : Answered
Chosen Option : C

Q.28 TATA H (Google Chrome) ¥ % &9 WA W TR Ugdl &9 Fipd H31 & forg frafafaa
T q P9 T P WidPpe ITENT fHar S 82

Ans o A Cirl +1
X B.ALt+9
X C.Alt+ 1
X D.Ctrl+9

Question ID : 8401606436
Status : Answered
Chosen Option : D

_

Q.29 HI3Y UTUETST (Mouse properties) @1 fRafefad # & w19 41 fawew 1t 8T an¢ Ay
e & BaRMl B WU A & g IuanT fFar smar g2

Ans X A UEC 3= (Pointer Options)
X B. faa@dl® (ClickLock)
X C. Sq0-faqd e (Double-click speed)
« D. e FIRBITH (Button configuration)

Question ID : 8401606424
Status : Answered
Chosen Option : D

Q.30 ﬁuﬁr@aﬁﬁﬁqmaﬁwﬁmﬁma@wmiﬁqﬁ%%m
feforea Rra ag= #3482

Ans o A DSL
% B. Wi-Fi
/5 C. 31Ud-3M7 (Dial-up)

X D. AT (Satellite)

Question ID : 8401606416
Status : Answered
Chosen Option : B
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TTSY (column borders) FATHR AUT TqH (table) T & forg Iuzw faran
X A. fohue ¢8d (Create table)

X B. fda® 29 (Quick table)
& C. 31¢qd (Draw table)
X D. 39 TG (Insert table)

STar 872
Ans

Q.31 THEH-as (MS-Word) 365 # fRafifad # & i a1 faeeu 94 (cell), A (row) 3N HiaH

Question ID : 8401606411
Status : Answered
Chosen Option : D

Q.32 Fmfafad TTa-TRa (MS-Excel) 365 BIHAT BT ATICYC FT GRIT? =12/8+6+4-2
Ans X A 12

X B.8

o C. 11

X D.10

Question ID : 8401606403
Status : Answered
Chosen Option : C

Q.33 THTH-a8 (MS-Word) 365 ¥ fafef@d & & {6 2@ A Tq( save), 99 TH (Save As),
31U T 3 STRWT (Open a New Document) 3M1fe 91 fawe g1d &2

25 A. SIcT (Data)
X B. R (Review)
X C. 8 (Home)
« D. BT (File)

Ans

Question ID : 8401606410
Status : Answered
Chosen Option : B

Q.34 guUy-as (MS-Word) 365 ¢9d A A (rows) 3N HTAH (columns) FIE HA & g
Fafafad & 3 o9 W te 9= e 781 82

X A. 3¢ AUE (Insert Left)

« B. 3¢ f§edi (Insert Between)
X C. 3 =T (Insert Right)

X D. 302 @l (Insert Below)

Ans

Question ID : 8401606413
Status : Answered
Chosen Option : D
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Q.35 TUUH-URT (MS-Excel) 365 ¥ Fafeif@d & @ &1 1 difored WaR TRUE a1 @ af
P15 A TRUE 872

Ans X A LET

X B.IF

 C.AND

« D.OR

Question ID : 8401606399
Status : Answered
Chosen Option : B

Q.36 THTH-UTGRUTSE (MS-PowerPoint) 365 & 3¢ &g & fAafefea # @ fdw faee &
E%R‘FI (equation)’ 3ifsstae gidr %?

Ans X A TRC (Text)
X B. IERETM (lllustrations)
X C.US3 (Add-ins)
o D. Rige (Symbols)

Question ID : 8401606397
Status : Answered
Chosen Option : B

Q.37 mg(PC)wwé-%mﬁﬁﬁﬂRmﬁmwmmﬁﬁaﬁq
|E?

Ans X A TERNI -> HIIC VI (Actions -> Account Settings)
& B. TH -> 3BI3¢ A (Tools -> Account Settings)
X C. & -> P13 A (View -> Account Settings)
X D. Tf&e -> 3HIdC W™ (Edit -> Account Settings)

Question ID : 8401606390
Status : Answered
Chosen Option : C

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/1258022443S3D99/1669267517 ...

Q.38 ?ﬁﬁ@ﬁﬁﬁﬁﬂmﬁ@amﬁmﬁmcumm%mmmﬁmﬂ
?

Ans o ALTXT
X B..ZIP
X C. WAV

X D. BAT

Question ID : 8401606423
Status : Answered
Chosen Option : A
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Q.39 FIHI 8T U Soi dcs dI5S A9 B HAfUd dil1P A AW B 3K I dlepd Ruforest
¥ rgpfad e & g ATHS WA T aTferd (8P &1 SUART HXdT 3|

Ans g A IR (Crawler)
X B. TSAW (Adware)
5 C. TR (Spooler)

X D. WISRR (Spyware)
Question ID : 8401606435
Status : Answered
Chosen Option : B
Q.40 2 ATTeTEew # fpea fFrawT 19 §2
Ans 5 p 220
X B.21°
o C.2%
X D.22
Question ID : 8401606432
Status : Answered
Chosen Option : A
=
Q.41 TUTH-UTGRUISE (MS-PowerPoint) ¥ Taf-d TTss &1 §Wrde a9 & G iais icwe
BT TG P
Ans X A.Ctrl +F1
X B.Ctrl+M
& C.Ctrl+D
2 D.Ctrl + X

Question ID : 8401606392
Status : Answered
Chosen Option : B

Q.42 fagfiafaa & | S 91 239 THUH-a8 (MS-Word) 365 T fShlee 29 872
Ans 3 A WTSd (File)

X B. [$T13 (Design)

& C. 1 (Home)

X D. W3¢ (Layout)

Question ID : 8401606408
Status : Answered
Chosen Option : D
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Q.43 gscquwﬁzaﬁsé,sﬁw—sﬁﬁmwﬁsﬁﬁw Y] o) Fefid goar
|
Ans X A 64

X B.127
X C.256
o D. 128

Question ID : 8401606427
Status : Answered
Chosen Option : C

Q.44 THTH-TE (MS-Word) 365 & a1 A& STHRHE T & forg Freferea & 9 fra siars
Riidwpe BT IUANT fbaT e 32

Ans o A Ctrl+N
X B. Shift + N
X C.Esc+N
75 D.At+N

Question ID : 8401606409
Status : Answered
Chosen Option : A

Q.45 fagferfad & A 19 91 TWd (Apple) GRT fAHRd Ifhed 39 TSR 82
Ans X' A TY (Edge)

X B. %M (Chrome)

o C. IBRI (Safari)

X D. BRRWI (Firefox)

Question ID : 8401606433
Status : Answered
Chosen Option : D

Q.46 ENIAC, EDVAC, 3fe Wil & dger & Iarevr g1
Ans X A A

 B.UuT

X c. &

X D. At

Question ID : 8401606425
Status : Answered
Chosen Option : B
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Q.47 TUTH-URIT (MS-Excel) 365 § UfRTal (rows) ®1 flIeM (delete) &1 T sraf~afafaa o
AP ATR?

Ans X A 3T > fSefie 2fie A (Insert > Delete Sheet Rows)
o B. ﬁ'ﬁ[ > fgdlie > fedfie e I (Home > Delete > Delete Sheet Rows)
X Cc.gl> fediie >%Fﬂ'c’32ﬂ?:’ﬁ\_rf(Draw > Delete > Delete Sheet Rows)
X D. f&ugT > fSie > fSeiie 2fie IS (Design > Delete > Delete Sheet Rows)

Question ID : 8401606400
Status : Answered
Chosen Option : A

Q.48 fgfIfEd & A 19 91 P61 AidHe THTH-UTaRUTSE (MS-PowerPoint) 365 ¥ iR

é‘q’(rra%nsitions tab) WA 3R FA5SH & d19 ZiferR wiea ¥ g Iuah far s
THar 82

Ans X A Alt+R
S B.At+S
X C.AL+A
o D. Alt +K

Question ID : 8401606398
Status : Answered
Chosen Option : A

Q.49 fgfrf@a & A 19 91 fawe s1e1 & UPe P A3 3R TSR & e s=me fFawl &
Je F1 YeNia Har g a1 d R Acad & IR (travel) H TP 3N Tl Tided
(destination) TR Ugd qd?

Ans X A HISd (Model)
2 B. cOIdist (Topology)
& C. UIIdId (Protocol)
< D. 3MfHeFRR (Architecture)

Question ID : 8401606415
Status : Answered
Chosen Option : B

Q.50 THEY-UIGRUISe (MS-PowerPoint) 365 H THUH-TGAH (MS-Excel) THRMIE TH¢ B4 &
fore FFafafaa # @ food fawer o1 Suah faar s 9o g2

Ans X A > th‘VFREf(Insert -> Forms)
X B.3¢-> 29 (Insert -> Table)
o« C.3¢-> 3fsaiae (Insert -> Object)
X D.3=9¢-> dE (Insert -> Chart)

Question ID : 8401606394
Status : Answered
Chosen Option : B

Section : General Knowledge Awareness
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Q1 Ry a1t wygar &1 Fufrf@a & § $i9 91 ®d $ & 07 H Rya 22
Ans g A STETERT

X B. HIgTsll GRI

X C.amaat

X D. FraEm

Question ID : 8401606437
Status : Answered
Chosen Option : D

Q.2 fayfufEd # 3 fea wew ¥ 38 fiifcdn ae-e A Afifa yRd &1 gl S e
Ans A T

X B.UsE

X C.aw

X D.g0

Question ID : 8401606457
Status : Answered
Chosen Option : D

Q.3 fofifad 3 A feg weg Bt i e o) Har @ fred 22
Ans X A TGS SIR SREUTEE HesT

X B. Rifdwy ok fgr
X C. Uf¥m S SR AT
o D. 3RUTTd U 3R 3

Question ID : 8401606443
Status : Answered
Chosen Option : A

Q4 TMaPsT B T 7 5w T o= weat § & forar 12
Ans X A. 1680

X B. 1672

X C.1690

« D. 1687

Question ID : 8401606439
Status : Answered
Chosen Option : A

Q.5 fdemrRr 3t 7 TgHe @ 2022 # frw Tyt # Yo wee Sftar ur?
Ans .,/A_?-ﬂﬁ?ﬁﬂ:f

X B. Ui Is ™

X C.cqd e

X D. gahamt

Question ID : 8401606458
Status : Answered
Chosen Option : B
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Ans X A §Rgdl deadfa gieHr
X B. Adt deraeif aerr
« C. IRgd! Uaauig arem
X D. Tqdl terada grern

Q.6 HRd # fra Yaadly gie1 & SR Riam o1 fierR sifif~am, 2009 T farar war ur?

Chosen Option : D

Question ID : 8401606448
Status : Answered

Q.7 14 T 2022 FY, U T g A A 759 750 & 17 &Y A1) F Ha qHRIE TR
wgwﬁﬁ?mmﬁm?

o A HERE
X B. sffsam
X C. Uiy sma

X D. ToRId

Ans

L2l

Chosen Option : D

Question ID : 8401606460
Status : Answered

_

Q.8 f3ur TRMTE Yod SR &7 (SAFTA) e qad SR saawiT 872
Ans X' A 3TRYTH (ASEAN)

« B. U1 (SAARC)
X c. fse (BRICS)
X D. 520 (G20)

Question ID : 8401606446
Status : Answered
Chosen Option : C

2022 & 7 ool & ThaweT Yord RH @ 3 i vamT fmar wa A
X A g< Ofdhe
« B. IHR0 Hiche
X C. 3oig |idhe

X D. $un Fihe

Ans

Q9 YRd 3R Aura A I3 Tl B SHs+ arell Ugd! "Wk TR 9hed o1 B o7

Question ID : 8401606461
Status : Answered
Chosen Option : C
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Q.10 frafifad & @ Bi= a1y AR SR T Y 9id W fRa g2
Ans X A gt ST HiGR

X B. TMGAR HieR
« C. 433 ¢t dfeR
X D. HgTeeiigRA AR

Question ID : 8401606438
Status : Answered
Chosen Option : C

waifera gl 82
Ans X A SfauM (SdHeaval SRNY) s, 1992
X B. dfaem (arseat ¥=ne) siffam, 2003
 C. Tfdur gaarfial g=iem) siffam, 2000
X D. I3y (Samtaar d=ne) sifefad, 1967

Q.11 frgfafed # @ 9 91 Ifaum= Iy ififam YR & @iy # oo v S 9

Question ID : 8401606455
Status : Answered
Chosen Option : D

Ans X' A UfEH ST
X B.WERTY
X c.fowr
o D. IR U™

Q.12 YRd F APl S Frafe § e 35 & Rrumae! o1 de gea wed 3ifis 82

Question ID : 8401606454
Status : Answered
Chosen Option : D

Q.13 fafafad ¥ @ fram srera a% ifes ot Hig vt i
Ans X A TS EIBRH

X B. B IH I

« C. 7% gllida

& D. T T SeTN

Question ID : 8401606440
Status : Answered
Chosen Option : B

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/1258022443S3D99/16692675173966439/2116119...  16/63

3@ Teachingninja.in



12/7/22, 5:21 PM

Q.14 fogffea & @ 19 91 YRd & dai R 3R 99 sftpd fssd @ ea S fu e
=t g2

Ans g A Gl
X B.og @
X C.Arar
X D. SRI-qrET @t

Question ID : 8401606444
Status : Answered
Chosen Option : B

Q.15 57 T P 1Pt W T B3I A FRTS P g1 ST BT 2-0 T B SHIA A giapt
$Ear wa-sfrar wfgen wdta AT 2022 Sfid?

Ans X A UGd
 B. s
X C. USRI

X D. SR

Question ID : 8401606459
Status : Not Answered
Chosen Option : --

Q.16 fafifea ¥ & H19 ® gx W Iare 3w aRumer 32

Ans A THTAU = SITHUT — Jed8™¥ (NNP = GNP — Depreciation)
X B. THTAUT = STAUT + e8I (NNP = GNP + Depreciation)
X C. T = Sl - Yeug™ (NNP = GDP — Depreciation)
< D. TATAU = SiSidt + g (NNP = GDP + Depreciation)

Question ID : 8401606447
Status : Answered
Chosen Option: C

Q.17 ﬁm‘ésrqsqaqﬁmq;?ﬁmﬁa (Slic) 3 s 2022 & fwior @’
PrIwH I BT

Ans X A 3MS3ATEET SHYTR
o B. AR SR
X C. agamsdt feeit
X D. 3E3fEel sirl

Question ID : 8401606456
Status : Answered
Chosen Option : A
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Q.18 frafafad & ¥ $19 F YR JaITE HHRT: Sl R TorTd ¥ fRa 82
Ans X A JATERAT 8 §GTE IR TAR §ETE

X B. ARIMSN SR SR Hif FEME

X C. TR demg IR URTE Fe3M8

o D. L HTAR §e=g IR HiSal demg

Question ID : 8401606445
Status : Answered
Chosen Option : B

Q.19 mﬁﬁﬁmﬁﬁﬁmwnﬁm1982a$amé’ran'§(RB|)$na=ﬁr$wﬁ
?

Ans X A Sl g&RE
X B. G (6
X C. YT U Vet
& D. T8 5. o

Question ID : 8401606450
Status : Answered
Chosen Option : C

Q.20 Ferufy Rrarsht weR™ & forg aRiug five grT WRewTe frar fae o sftar wam ur?
Ans X A. 1690

X B. 1680
X C. 1700
& D. 1670

Question ID : 8401606441
Status : Answered
Chosen Option : B

Q.21 YRA ¥ HRAYT BT H19 T Srede ST Bt ATRAT SR AFEia gemei iR wgfa
HETdl & WIayT A He&fid 872

Ans X A 3w 44
X B. 3= 39 A
X C. 3o 40
o D. 313G 42

Question ID : 8401606451
Status : Answered
Chosen Option : B
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Q.22 YR & AU BT Fq 58 fFuA Heiftra 32
Ans X A UAfafad 3 forg ur

X B. 35Ul &1 SRiw

o C.pufd & w0 H Fafem & forg dvgan

X D. Iyufa & fafes &1 adie

Question ID : 8401606452
Status : Answered
Chosen Option : C

Q.23 R3S (RBI) G&T SATYfd & TR IHIRIS SURN, M4, My, M3 3R M, & 3Hihs THTRIT
T 3| Fafafaa o & o9 a1 M, $T U g 82

Ans o A TS dp! 31 Fae Frafey st
X B4
X c. feurs feuferea
X D. SIHR §d 8 P 1Y FId STHT

Question ID : 8401606449
Status : Answered
Chosen Option : D

Q.24 fagffaa & A H19 W FYT YR B I9E & IR F TAd 82
Ans A IEUHT F G-IETE U™ §R 41 99 a1G 4aTad 81 9 & |
X B. AT Wel B 31 30 9N A HH gl 81 Tl ¢
X C. AHTH e BT 31 25 I § HH -Ta1 &1 Gahel gl
X D. YR & IWIFU I9 GHT F T THTIR 81 & |

Question ID : 8401606453
Status : Answered
Chosen Option : B

Q.25 TETAT Tieh 7 U 0 qre’ & g Jravaedt & 3o onyd A WS F B a1 3R
T Hd Y fobar ur?

Ans X' A 15 TaR], 1930
X B. 21 AT, 1930
& C. 127, 1930

< D. 8 S, 1930

Question ID : 8401606442
Status : Answered
Chosen Option : C

Section : Reasoning
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Q1 & 1S g A Ut fpait 7w wEt €, e e ugd 3R e 91¢ v faww G 872
32249158685937285734635146
Ans X A1
X B.2
X c.3
 D.0

Question ID : 8401606499
Status : Answered
Chosen Option : B

Q.2 quAT FT A T A ufeg FR1 g 391 A gl a8 W g1 Bl gH AN T &
TPl T DI Tell 8" | ST BT THAT & T Hae 872

Ans A TG
X B. 3T
X C. &5
X D.H

Question ID : 8401606473
Status : Answered
Chosen Option : B

Q.3 IR HeR-Oqg U Mu §, RFrd | 9 f5eh 7 e 7% ¥ ve w0 §, 3R us eRiFma B
I R SHER-TYE PTIqT PN
Ans X A FECZV

X B.ZYWTP
« C. OPRUY
X D. DCAXT

Question ID : 8401606483
Status : Answered
Chosen Option : B

Q4 IR eR-aqg Hie Ry wy 7, ' @ &9 fasht 7 5l a8F A v wum 8, sk te
ST B 1 3 A AGR-TYE BT P71 9u7 H¥ |
Ans ¢ A BULK:BKLU : EXON
< B. TRACK : ACKRT : DFNUW
2 C. SLICE : EICLS : HKFOV

Z5 D. PRICE : EICPR : HKFSU

Question ID : 8401606485
Status : Answered
Chosen Option : A
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Q.5 fAfyd pe U A, “LEE” Y “44” MR “LOU” & “96” & U | Hadw fhal wiraT 2l
A UTHT A “GAA” B FA Feas fpar smem?
Ans 5 A.38

X B.102
X C.98
 D.18

Question ID : 8401606471
Status : Answered
Chosen Option : D

Q.6 IR TEI-gH faw mu §, R | @ Bl 7 5t a8 @ v wur €, o ue SR B
I SR HRAT-H BT T94 B |
Ans X A.100:26
X B.16:5
& C.8:4
2 D. 120 : 31

Question ID : 8401606501
Status : Answered
Chosen Option: C

Q7 o
'@ FOHY ‘" B
%' T AT IO §
& F HY 'FE g, AR
'$' T HY T T,
ar F=efEe gdfetor & 2 F e W oFT HwE?
35@7%4&(9$3)%5&4="

Ans X A 146
* B.52.25
X C.116
« D.26

Question ID : 8401606505
Status : Answered
Chosen Option : D
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Q.8 I fawey o1 79 &, o 3eR-T4g g/ & Hed 981 wey §, Wit - fAw v srer-wgg
TH S A gl

FPO : KAD
Ans X A.BAY:DTC

X B.NEP:SzX
X C.ILU: NAF
« D.GTU: LEJ

Question ID : 8401606481
Status : Answered
Chosen Option : D

Q.9 IR FEr-gw T M g, Rd @ i fheht 1 et ot @ wo gwH €, 3R o ST B
I T H=AT-GH T 79 B |
Ans o A 11270
X B.39:26
X C.63:42

2 D.30:20

Question ID : 8401606503
Status : Answered
Chosen Option : B

Q.10 ?ﬁmmmaﬁ,WW—W%HWHﬁWH%,FﬁﬁﬁEWW-W%FW
|

BLINK : KLICK
Ans X A.SISTE : TESIS

« B. PRIDE : YRIOE
 C.BLISS : SLIST
X D. PLATE : TEALM

Question ID : 8401606480
Status : Answered
Chosen Option : B
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Q.11 T g § @ I Ueg BT T BIME, S 2 RE T g F w9
LIRIL
Ans o A RADAR
X B. GATED
X C.CIvVIL
X D. CHALK

Question ID : 8401606478
Status : Answered
Chosen Option: C
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Q.12 3 Y fawpeut A | 39 T &1 9949 B, ol Fufefed g § yyaraes faws (7) 91
wfereuia ) wadt 31

1,2,1,3,4,5, 20, 8, 27, 12, 243, 17, 254, ?
Ans o A 23
/< B.57
/< C.102

X D.36

Question ID : 8401606495
Status : Answered
Chosen Option : A

OB A.BFHTEA BIr T
'‘A#B FTITE'A B FTafa
ASB & HTE A BH g g
'A% B FITEABHRAATE
A@B FHIZT A B s &
A=l e # ¥ e Fi9-a1 Fua & FFer 51 gar 82

S+PSCHD%H@L
Ans X A D, SPIHRI

X B.S,P,3RL IR T

X c.c LF sl

& D.L, ST UEEI

Question ID : 8401606477
Status : Answered
Chosen Option : B
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Q.14 9R rpfagi & 7 7, ord A fF fadt 7 feht 98P I ve 70 7, iR v srva g1
I T P BT 7gq B |

& A €$

Ans

Question ID : 8401606489
Status : Answered
Chosen Option : A

Q.15 Ue safed ®1 ulv=d gd §Y, St 7 Ut wgelt § H81, "8 AL Ufd B sHaldl 984 1 Al
F ufa o7 3 oyt & ufy 1 39 wfda | Far Way 72

Ans X' A FEIHETHT
X B. &AM
X C.fuar
& D. UiarATd

Question ID : 8401606474
Status : Answered
Chosen Option : B

Q.16 fopdt fAif3a g wTaT &, “Lu” ®Y “VN” 3R “KI” BT “LK” foraT STTar 81 39 HTeT & “Luy”
Y ferar sem?

Ans X A.ZNV
« B.ZWO
X C.NVW
* D. VWN

Question ID : 8401606470
Status : Answered
Chosen Option : B
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Q.17 3T Y faweut A @ S0 H&I &1 994 B, ol Faffed geon § yyaraes fas (7) a1
wforTia % Faedt B

10, 5, 2, 20, 10, 2, 40, 12, 4, 80, 24, 12, ?, 26, 48
Ans X A 130
X B. 48
« C. 160
X' D. 125

Question ID : 8401606494
Status : Answered
Chosen Option : C

QI8 & o1& argpfadl # @ 5w sl @ gRT, S A & 7 g F wEw B

Ans
@

Q)
» &
™ »
Jko
L] -
@
xc @-
L)

Question ID : 8401606487
Status : Answered
Chosen Option : A
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Q.19 1R ey ¢ aTew & Us W € R arar Sreyaflud 81 MU 81 eRl Bt 99 aiery (blea)
T qrafafRud #¥ 3R 3TF 9 gt TR ford |
What all | needed is a piece of paper to ACTER it.

Ans X A CATER

« B. TRACE
X C.CARET
< D. CRATE

Question ID : 8401606467
Status : Answered
Chosen Option : A

Q.20 ¥} fAf¥d e W A, “CLOCK” 1 “BKUBJ” for@T wirT 8 3R “WATCH” HI “VESBG”
forar sirar 81 39 HIOT § “TIME” 9 forar siemn?

Ans X A.SOLU
X B. SULI
& C.sOoLo
& D. SOLI

Question ID : 8401606468
Status : Answered
Chosen Option : A

Q.21 gf FafafeT sieR-amg & 1, 4, 5, 9 3R 113 31&R B AT TS AISF s §7a1 8, a1 39
ISP e b AW H PIF-AT &R MTM?

DDRBTCTYIRE
Ans X Al
 B.B
& C.E
KX DT

Question ID : 8401606466
Status : Answered
Chosen Option : B
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Q.22 Il%

A-BFRATT A BIAGE

'A+ B & 3T g A B H g B

‘A x B IFTEA BHTHE

AB # 3 g 'A BEH I ¢

frafaf@a o= & N &7 K @ 11 g9y 872

KxP+L/M=-0+N

Ans X A, QIIAT
X B. W
& C. 3fd
X D.fuar

Question ID : 8401606476
Status : Answered
Chosen Option : A

Q.23 R TE&-A® iy v &, Rrd @ 64 feeht 7 ff 8% @ ve au §, o e sriva B
I TG H&IT-FAF BT T B
Ans X A.13:4:52
K B.1:2:2
X C.6:3:15
@ D.78:9:70

Question ID : 8401606502
Status : Answered
Chosen Option : D

Q.24 oy 77T fawpeul # & W SER-THFHT 997 B, S Fafifaa yaar & uyars g (2) $1
wfoeTia F d@dr g1

BIHP, JRDK, FMLT, NVHO, JQPX, ?
Ans X A RALS

« B.RZLS
X C.RzZKS
X D.SZLR

Question ID : 8401606463
Status : Answered
Chosen Option : B
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Q.25 IR ¥ fou U &, R | i+ fpedt 7 fpalt a8ie @ vpaw= €, ok to eiva 81 39
SR Mg T TTT B

Ans o A ACE

X B.ICE

X C.EAR

< D.OouT

Question ID : 8401606482
Status : Answered
Chosen Option : D

Q.26 7Ty g & 39 T JAIS BT TUT B9, Sl Hive w4 A @ Fgl &) yfawnfig &=
THd1 g 3R AU U gefiewur &t Agfera &= ghar gl

(15@5@ 25) @20 @ (25 @ 6) @ -26
Ans K A X, + =+ 5 —
HB.x, + = 5 — +
XK C.+, = x + = —
o D.x, + + — + =

Question ID : 8401606506
Status : Answered
Chosen Option : C

Q.27 9R 3&R-aqg Aie iy e &, fRrd @ 6+ st = st a8 @ oo au B, siR T
SR § 1 I ST 3H&R-THE P o1 997 ¥ |
Ans X A RAMAN : MANAR : KYLYP

o’ B. JAGAT : GATAJ : HCVCL
#5 C. JEHAN : HAJEN : FYHCL
#5 D. SARAL : LARAS : JYPYQ

Question ID : 8401606486
Status : Answered
Chosen Option : B

Q.28 TH ASH! Bl TR B 3R AT F3d T, 519 (YY) A Fel, "TF AN A sPAd e &
¢ B 951 2| TR B 3T ¥ aswl A 59 B R 6AY 72

Ans A fod
X B.¥eT
7 C.araT
XK D. W

Question ID : 8401606475
Status : Answered
Chosen Option : B
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Q.29 'AIRMAN', 'MARINE' ¥ I} g Hdftd g Y @RE SHORE' ' A Hafia 71
Ans X A. BEACH

X B.COAST

« C. HORSE

2 D. LAND

Question ID : 8401606465
Status : Answered
Chosen Option : C

Q.30 IR FEr-gW fiu 7 §, RFd § & et 7 fit o @ ve gwE § 3R U SriTa B
I SR HRAT-H HT 997 B |

Ans o A 15:62

X B.22:92

X C.19:86

X D.36:153

Question ID : 8401606504
Status : Answered
Chosen Option : A

_

Q.31 I W= P UgaE FY, 5t FuferiEa gaen & Gdfta a8t 21

51,102, 103, 104, 101, 200, 203, 204, 201, 402, 403, 404, 401
Ans o A 200

X B.401
X C.51
2 D. 102

Question ID : 8401606497
Status : Answered
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Status : Answered
Chosen Option : B

Q.53 ‘IS oI, TSI HeaTor Aipifa o1 Tet 31 oam 82
Ans 2 A T 3R FH TeT G A §

X B. I 39 # t e avd §

X C. U= ¥el guit d @

< D. TS U1 S Hd §

Question ID : 8401606531
Status : Answered
Chosen Option : B

Q.54 @@ BT fadH =1 g2
Ans KA B

X B.EW8R

o C. 3

X D.Ymyd

Question ID : 8401606555
Status : Answered
Chosen Option : A

Q.55 Iy @1 watgardt e 2-
Ans X A &l

X B. I

X c. fayrad

& D. AU

Question ID : 8401606548
Status : Answered
Chosen Option : A

Section : General English
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Q.1 Four sentences have been given out of which three are connected in some manner
and one is different. Select the one that is different.

Ans X A. The boy had no friends to care for, or to care for him.
< B. These were not the only dismal feelings which depressed Oliver.
«” C. Mr. Bumble grasped the undertaker by the arm and led him into the building.

25 D. He was alone in a strange place.

Question ID : 8401606585
Status : Answered
Chosen Option : C

Q.2 Select the most appropriate option to fill in the blank.
The evidence clearly that the accused is guilty.

Ans X A. brings up
< B. brings round
< C. brings off
«” D. brings out

Question ID : 8401606570
Status : Answered
Chosen Option : C

Q.3 Select the most appropriate option to fill in the blank.
If he the proper documents, he would have got his passport much earlier.

Ans X A. has produced
< B. would have produced
25 C. produces
«” D. had produced

Question ID : 8401606577
Status : Answered
Chosen Option : D

-
Q.4 Select the most appropriate option to fill in the blank.
Do you know the girl in the first row?
Ans o A sitting
< B. tosit
X C.sat
< D. sit

Question ID : 8401606569
Status : Answered
Chosen Option : B
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Q.5 Select the sentence with correct punctuation and capitalisation.
Ans X A.lrecently read ‘The Prodigal Daughter’ by Jeffrey archer.

& B. | recently read ‘The Prodigal Daughter’ by Jeffrey Archer.
< C. I recently read The Prodigal Daughter by ‘Jeffrey Archer’.
2 D. | recently read ‘the Prodigal daughter’ by Jeffrey Archer.

Question ID : 8401606573
Status : Answered
Chosen Option : B

Q.6 Select the most appropriate option to fill in the blank.
she didn’t know much about climbing, she preferred to go alone.

Ans X A. Whether
«” B. Although
< C. Because
75 D. Whereas

Question ID : 8401606565
Status : Answered
Chosen Option : B

—

Q.7 Select the most appropriate meaning of the given idiom.
Having a field day

Ans X A. Spending time relaxing and sleeping
< B. Being busy in business meetings
/X C. Feeling depressed over losing something

«” D. Getting a lot of pleasure by doing something

Question ID : 8401606590
Status : Answered
Chosen Option : A

Q.8 Parts of the following sentence has been given as options. Select the option that has a
spelling error. If you don’t find any error, select ‘No error' as your answer.
The public bombarded the company with complaintes to have the price increase
revoked.

Ans X A. to have the price increase revoked
5 B. No error
#5 C. The public bombarded

«” D. the company with complaintes

Question ID : 8401606606
Status : Answered
Chosen Option : D
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Q.9 Select the most appropriate option to fill in the blank.
He promised the profit with us.

Ans X A.share
X B. sharing
¥ C. to share
25 D. shared

Question ID : 8401606568
Status : Answered
Chosen Option : C

Q.10 Select the most appropriate option to fill in the blanks.
The doctor explained all the details the treatment the family members
of the child.

Ans X A. for; for
< B.on;to
o C.of; to
25 D. on; for

Question ID : 8401606567
Status : Answered
Chosen Option : C

Q.11 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

A. There was a good deal of variety in life at Kyirong.

B. In summer, caravans came through every day.

C. After the rice harvest in Nepal, men and women brought rice in baskets and
exchanged it for salt, one of the most important exports of Tibet.

D. It is brought from the lakes in Changthang.

Ans ¢ A.ABDC
< B.ACBD
« C. ABCD
< D.ADCB

Question ID : 8401606580
Status : Answered
Chosen Option : B

Q.12 Select the most appropriate option to collocate with the word ‘humour’ to fill in the
blank.
My sister has a peculiar of humour. She talks very sarcastically with me.

Ans X A. logic
25 B. intelligence
25 C. wisdom
«” D. sense

Question ID : 8401606592
Status : Answered
Chosen Option : B
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Q.13 Select the most appropriate option that can substitute the underlined word in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.
The first batch of cheetahs from Namibia was discharged at Kuno National Park in
Madhya Pradesh.

Ans X A.issued

< B. No substitution required
< C. surrendered
o’ D. released

Question ID : 8401606586
Status : Answered
Chosen Option : C

Q.14 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

A. He reminded me of a loving schoolteacher or a doting grandfather or an excellent
friend to these children irrespective of the difference in age.

B. Kalam would regularly address large groups of students followed by question-
answer sessions.

C. Then he would make children recite some of the important lines after him.

D. He would take individual questions and answer them.

Ans ¢ A.CBDA
« B.BDCA
X C.BADC
< D.DACB

Question ID : 8401606583
Status : Answered
Chosen Option : B

Q.15 Four sentences have been given out of which three are connected in some manner
and one is different. Select the one that is different.

Ans X A. The Gobi Desert is a large desert in Asia.
25 B. It consists entirely of mountains and sands and valleys.
o” C. Several important cities'were located along the Silk Road.

< D. ltis reported to be so long that it would take a year to go from end to end.

Question ID : 8401606584
Status : Answered
Chosen Option : B

Q.16 Select the option that expresses the given sentence in active voice.
The courier-boy was attacked by my dog when he was handing over a package to me.

Ans # A. My dog attacked the courier-boy when he was handing over a package to me.
/% B. The courier boy attacked my package when he was handing over a dog to me.
5 C. The courier boy attacked my dog when he was handing over a package to me.

25 D. My dog was attacking the courier-boy when he was handing over a package to me.

Question ID : 8401606579
Status : Answered
Chosen Option : C
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Q.17 Select the most appropriate option to fill in the blank.
| was taught to read a at the age of seven.

Ans X A. calander
< B. calandar
«” C. calendar
#5 D. celandar

Question ID : 8401606604
Status : Answered
Chosen Option : A

Q.18 Select the most appropriate option to fill in the blank.
This is an version of the novel “Oliver Twist” by Charles Dickens.

Ans X A. abbriviated
«” B. abbreviated
X C. abrreviated
< D. abrriviated

Question ID : 8401606605
Status : Answered
Chosen Option : B

-
Q.19 Select the most appropriate option to fill in the blanks in the given sentences.
Beer is chiefly in Poland and the Baltic provinces.
Mother duck crossed the road with its in tow.
Ans X A.brewed; brewed
#5 B. brood; brewed
«” C. brewed; brood
< D. brood; brood
Question ID : 8401606599
Status : Answered
Chosen Option : B
—
Q.20 Select the most appropriate option to fill in the blank.
He the piano since seven o’clock this morning. He has only just finished.
Ans X A plays
< B. played

«” C. has been playing

25 D. is playing

Question ID : 8401606576
Status : Answered
Chosen Option : D
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at optimal times.
C. Rice is central to the diet of people in Bali.
D. Terraced rice fields can be seen throughout the island.

Ans X A. DACB
«” B. CDAB
#< C.CBDA
& D.ADBC

A. Cultivating hill-side terraces helps to maximise Bali’s limited resources.
B. Terraces are also easier to irrigate and can be fine-tuned to flood specific channels

Q.21 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

Question ID : 8401606582
Status : Answered
Chosen Option : B

Q.22 Select the most appropriate option to fill in the blank.
We all had lunch today an ltalian restaurant.

Ans ¢ A.on
< B.into
o C. at
X D.by

Question ID : 8401606566
Status : Answered
Chosen Option : C

Q.23 Select the most appropriate option to fill in the blank.

Ans X A. bow
5 B. boy

«” C. buoy
< D. bough

A yellow was tied to the rock to guide the boats in the sea.

Question ID : 8401606598
Status : Answered
Chosen Option : B

Q.24 Select the most appropriate option to fill in the blank.
If you do not keep children busy in some activity, they will

Ans X A eagerly
25 B. suddenly
o C. surely
25 D. badly

watch TV.

Question ID : 8401606563
Status : Answered
Chosen Option : B
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Q.25 Select the option that expresses the given sentence in reported speech.
“Please send me a mail to confirm your participation in the function,” Mohan said to
Sujata.
Ans X A. Mohan said please Sujata sent him a mail to confirm her participation in the function.
«” B. Mohan requested Sujata to send him a mail to confirm her participation in the
function.
25 C. Sujata requested Mohan to send them a mail to confirm her participation in the
function.
< D. Mohan requested Sujata to send her a mail to confirm his participation in the
function.
Question ID : 8401606574
Status : Answered
Chosen Option : B
_—
Q.26 Select the option that expresses the given sentence in direct speech.
| requested the cab driver to stop there for a minute.
Ans X A.lsaid to the cab driver, “Please would you like to stop here for a minute.”
«” B. | said to the cab driver, “Please, stop here for a minute.”
< C. | said to the cab driver, “Please, stop there for a minute.”
< D. | said to the cab driver, “Please, you can stop here for a minute.”
Question ID : 8401606575
Status : Answered
Chosen Option : C
e =
Q.27 Select the option that expresses the given sentence in passive voice.
The Battle of Panipat between Babar and Ibrahim Lodhi established Mughal authority
over Delhi.
Ans X A. Mughal authority over Panipat was established by the Battle of Delhi between Babar
and Ibrahim Lodhi.
25 B. Mughal authority over Delhi had been established by the Battle of Panipat between
Babar and Ibrahim Lodhi.
25 C. The Battle of Panipat between Babar and lbrahim Lodhi was being established by the
Mughal authority over Delhi.
«” D. Mughal authority over Delhi was established by the Battle of Panipat between Babar
and Ibrahim Lodhi.
Question ID : 8401606578
Status : Answered
Chosen Option : C
—_—
Q.28 Select the most appropriate option to collocate with the word ‘cards’ to fill in the
blank.
Bring a cards. | will show you some tricks.
Ans X A.bunch
< B. packet
< C. bundle
«” D. pack
Question ID : 8401606591
Status : Answered
Chosen Option : C
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Q.29 Select the most appropriate punctuation mark to fill in the blank.
The chief rivers of South India are Mahanadi, Godavari, Krishna, and Kaveri.

Ans X A comma (,)
< B. semi-colon (;)
” C. colon (3)
25 D. hyphen (-)

Question ID : 8401606572
Status : Answered
Chosen Option : A

Q.30 Select the most appropriate option that can substitute the underlined word in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.
He had a prominence for fearlessness and was regarded as an effective speaker.

Ans X A. no substitution required
5 B. standing
25 C. prestige
” D. reputation

Question ID : 8401606588
Status : Answered
Chosen Option : D

Q.31 Select the option that completes the given proverb correctly.
A bad workman quarrels .

Ans o A with his tools
X B. with his wife
5 C. with everyone
2< D. with his friends

Question ID : 8401606589
Status : Answered
Chosen Option : D

Q.32 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

A. For the first time, NASA tested a crash between a spacecraft and an asteroid.

B. The crash happened millions of kilometres from Earth.

C. But, NASA wanted to prove that people were able to stop an asteroid from crashing
into our planet.

D. The asteroid wasn’t traveling towards Earth, so it wasn’t dangerous.

Ans X A ABCD
X B.ADCB
X C.ACBD
« D. ABDC

Question ID : 8401606581
Status : Answered
Chosen Option : D
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Q.33 Select the option which is NOT an antonym of another word by way of adding the
prefix ‘Mis-‘.
Ans & A Mistress
& B. Misrepresent
/5 C. Mistreated

Z5 D. Mismeasure

Question ID : 8401606596
Status : Answered
Chosen Option : A

Q.34 Select the most appropriate option to fill in the blank.
Akhil was angry about this issue, but he flew into rage when he heard that he

was being dismissed.
Ans X A.much

< B. rather

2 C.too

«” D. enough

Question ID : 8401606562
Status : Answered
Chosen Option : D
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Q.35 Select the most appropriate ANTONYM of the given word.
Paucity

Ans X A.Impudence
/5 B. Poverty
«” C. Affluence
< D. Deficiency

Question ID : 8401606594
Status : Answered
Chosen Option : A

Q.36 Select the most appropriate option to fill in the blank.
Rahul and Mohit were busy analysing data they didn’t have time for proper

lunch.
Ans X A. Though

o B. As
< C.Incase
< D. Despite

Question ID : 8401606564
Status : Answered
Chosen Option : B
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Q.37 Select the most appropriate synonym of the given word.
Delectable

Ans & A Appetising
< B. Horrible
25 C. Distasteful
75 D. Animated

Question ID : 8401606602
Status : Answered
Chosen Option : C

Q.38 Select the most appropriate synonym of the given word.
Alacrity

Ans X A.Aversion
< B. Reluctance
" C. Alertness

< D. Lethargy

Question ID : 8401606603
Status : Answered
Chosen Option : B

-
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Q.39 Select the most appropriate option that can substitute the underlined word in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.
Eight trainee mountaineers have been salvaged after as many as 29 of them got
trapped in an avalanche on a peak in Uttarakhand.

Ans X A. exploited
o” B. rescued
25 C. No substitution required
< D. delivered

Question ID : 8401606587
Status : Answered
Chosen Option : A

Q.40 Select the most appropriate ANTONYM of the given word.
Sacrosanct

Ans X A Revered
«” B. Desecrated
< C. Divine
25 D. Blessed

Question ID : 8401606595
Status : Answered
Chosen Option : B
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Q.41 Select the most appropriate option to fill in the blank.
Last night, | saw a suspicious man in our lane under a lamp post.

Ans X A. hangingin
«” B. hanging about
< C. hanging up
25 D. hanging out

Question ID : 8401606571
Status : Answered
Chosen Option : B

Q.42 Select the most appropriate option to fill in the blank.

She tried to ____ through the crack in the door but couldn’t make out much.
Ans X A. pair
«” B. peer
5 C. pear
< D. pare
Question ID : 8401606597
Status : Answered
Chosen Option : B
-

Q.43 Select the most appropriate synonym of the given word.
Abate

Ans X A Incite
< B. Revive
” C. Reduce
75 D. Extend

Question ID : 8401606601
Status : Answered
Chosen Option : C

_—

Q.44 Select the most appropriate option to collocate with the word ‘war’ to fill in the blank.
In February this year, Russia war against Ukraine.

Ans o A declared
5 B. attacked
/< C. asserted
< D. stated

Question ID : 8401606593
Status : Answered
Chosen Option : B
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Q.45 Select the most appropriate option to fill in the blanks.
Decked up in her outfit, Sanyukta held her horse by the
awaiting the order to mount.

Ans X A. bridal; bridal
25 B. bridle; bridle

, impatiently

«” C. bridal; bridle
< D. bridle; bridal

Question ID : 8401606600
Status : Answered
Chosen Option : B

Comprehension:

In the following passage, some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

Marco Polo was born in 1254. His family were Ventians, but it is unclear if he was (1)

born in Venice or if the birth took place (2) the island of Curzola off the Dalmatian
coast, (3) his father and uncle had established a trading post.We do know that Marco
Polo (4) at least some part of his childhood in Venice. He received a good education
that (5) , among other things, classes in French and ltalian.

SubQuestion No : 46
Q.46 Select the most appropriate option to fill in the blank No. 1.
Ans X A. essentially

25 B. incredibly

< C. probably
” D. actually

Question ID : 8401606608
Status : Answered
Chosen Option : C

Comprehension:

In the following passage, some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

Marco Polo was born in 1254. His family were Ventians, but it is unclear if he was (1)

born in Venice or if the birth took place (2) the island of Curzola off the Dalmatian
coast, (3) his father and uncle had established a trading post.We do know that Marco
Polo (4) at least some part of his childhood in Venice. He received a good education
that (5) , among other things, classes in French and lItalian.

SubQuestion No : 47
Q.47 Select the most appropriate option to fill in the blank No. 2.
Ans X A.to

«” B.on
& C.in
< D.into

Question ID : 8401606609
Status : Answered
Chosen Option : A
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Q.48
Ans

Comprehension:

In the following passage, some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

Marco Polo was born in 1254. His family were Ventians, but it is unclear if he was (1)
born in Venice or if the birth took place (2) the island of Curzola off the Dalmatian

SubQuestion No : 48
Select the most appropriate option to fill in the blank No. 3.
75 A. wherever

7< B.when
" C. where
< D. there

his father and uncle had established a trading post.We do know that Marco
at least some part of his childhood in Venice. He received a good education
, among other things, classes in French and ltalian.

Question ID : 8401606610
Status : Answered
Chosen Option : D

Ans

Comprehension:

In the following passage, some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

Marco Polo was born in 1254. His family were Ventians, but it is unclear if he was (1)
born in Venice or if the birth took place (2) the island of Curzola off the Dalmatian

SubQuestion No : 49
Q.49 Select the most appropriate option to fill in the blank No. 4.
75 A. spends

/< B.spend
" C. spent
25 D. spending

his father and uncle had established a trading post.We do know that Marco
at least some part of his childhood in Venice. He received a good education
, among other things, classes in French and ltalian.

Question ID : 8401606611
Status : Answered
Chosen Option : B
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Q.50
Ans

Comprehension:

In the following passage, some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

Marco Polo was born in 1254. His family were Ventians, but it is unclear if he was (1)

born in Venice or if the birth took place (2) the island of Curzola off the Dalmatian
coast, (3) his father and uncle had established a trading post.We do know that Marco
Polo (4) at least some part of his childhood in Venice. He received a good education
that (5) , among other things, classes in French and ltalian.

SubQuestion No : 50
Select the most appropriate option to fill in the blank No. 5.
< A held

/< B. entered
< C. received
" D. included

Question ID : 8401606612

Chosen Option : B

Status : Answered

Q.51
Ans

Comprehension:
Read the given passage and answer the questions that follow.

The Archaeological Survey of India (ASI) has cleared some stunning ancient remains in the
Bandhavgarh Forest Reserve. ASI exploration has recorded 26 temples, 26 caves, 2
monasteries, 2 stupas, 24 inscriptions, 46 sculptures, other scattered remains and 19 water
structures in Madhya Pradesh’s Tiger haven. These finding are from different historical time
zones and cover the reigns of the kings Shri Bhimsena, Maharaja Pothasiri, Maharaja
Bhattadeva. ASI deciphered the inscriptions found there and discovered that the names of
various places mentioned here are Kaushami, Mathura, Pavata (Parvata), Vejabharada and
Sapatanaairikaa. An ASI team covered nearly 170 sq. km. falling in the area of the
Bandhavgarh Tiger Reserve over months-long exploration of the region which was
undertaken for the first time since 1938.

26 ancient temples/relics unravelled by ASI are of Kalachuri period which spans from the 9th
century CE to the 11th Century CE. Besides the 26 caves which date back from the 2nd to 5th
Centuries CE, archaeological remains of the Mahayana sect of Buddhism such as chaitya-
shaped doors and cells containing stone-beds have also been reported by the ASI team.
The monasteries, stupas, and 24 Brahmi inscriptions found by the ASI are also from the 2nd
Century CE to the 5th Century CE. 46 sculptures, 20 scattered remains and 19 water
structures date from the 2nd -15th Century CE. Among the 46 sculptures found by the ASI
there is a giant Varah sculpture which is one of the largest found by the agency.

The exploration was conducted by ASI’s Jabalpur circle. Being a tiger reserve, unrestricted
access to tourists to the archaeological sites is unlikely to be allowed. Bandhavgarh Forest
Reserve is best known for Evergreen Sal forest and Mixed forest. About 515 species of plants
are found there and it is also home to 242 species of birds and many species of reptile and
insects. The major mammal of Bandhavgarh is the Tiger. Apart from that, Leopard, Wild dog,
Wild cat, Hyena, Wolf, Chital, Sambar, Black Buck, etc., are easily seen there.

SubQuestion No : 51
After reading the passage it can be inferred that it is:
< A. areport released by ASI

«” B. a news report
5 C. a magazine article

25 D. a government release

Question ID : 8401606614

Chosen Option : A

Status : Answered
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Comprehension:
Read the given passage and answer the questions that follow.

The Archaeological Survey of India (ASI) has cleared some stunning ancient remains in the
Bandhavgarh Forest Reserve. ASI exploration has recorded 26 temples, 26 caves, 2
monasteries, 2 stupas, 24 inscriptions, 46 sculptures, other scattered remains and 19 water
structures in Madhya Pradesh’s Tiger haven. These finding are from different historical time
zones and cover the reigns of the kings Shri Bhimsena, Maharaja Pothasiri, Maharaja
Bhattadeva. ASI deciphered the inscriptions found there and discovered that the names of
various places mentioned here are Kaushami, Mathura, Pavata (Parvata), Vejabharada and
Sapatanaairikaa. An ASI team covered nearly 170 sq. km. falling in the area of the
Bandhavgarh Tiger Reserve over months-long exploration of the region which was
undertaken for the first time since 1938.

26 ancient temples/relics unravelled by ASI are of Kalachuri period which spans from the 9th
century CE to the 11th Century CE. Besides the 26 caves which date back from the 2nd to 5th
Centuries CE, archaeological remains of the Mahayana sect of Buddhism such as chaitya-
shaped doors and cells containing stone-beds have also been reported by the ASI team.
The monasteries, stupas, and 24 Brahmi inscriptions found by the ASI are also from the 2nd
Century CE to the 5th Century CE. 46 sculptures, 20 scattered remains and 19 water
structures date from the 2nd -15th Century CE. Among the 46 sculptures found by the ASI
there is a giant Varah sculpture which is one of the largest found by the agency.

The exploration was conducted by ASI’s Jabalpur circle. Being a tiger reserve, unrestricted
access to tourists to the archaeological sites is unlikely to be allowed. Bandhavgarh Forest
Reserve is best known for Evergreen Sal forest and Mixed forest. About 515 species of plants
are found there and it is also home to 242 species of birds and many species of reptile and
insects. The major mammal of Bandhavgarh is the Tiger. Apart from that, Leopard, Wild dog,
Wild cat, Hyena, Wolf, Chital, Sambar, Black Buck, etc., are easily seen there.

SubQuestion No : 52
Q.52 What is the passage mainly about?
Ans X A. The flora and fauna of the Tiger Reserve

«” B. The ancient finds in Bandhavgarh Forest Reserve
/5 C. The Bandhavgarh Forest Reserve

< D. The archaeological survey in the Tiger Reserve

Question ID : 8401606615
Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage and answer the questions that follow.

The Archaeological Survey of India (ASI) has cleared some stunning ancient remains in the
Bandhavgarh Forest Reserve. ASI exploration has recorded 26 temples, 26 caves, 2
monasteries, 2 stupas, 24 inscriptions, 46 sculptures, other scattered remains and 19 water
structures in Madhya Pradesh’s Tiger haven. These finding are from different historical time
zones and cover the reigns of the kings Shri Bhimsena, Maharaja Pothasiri, Maharaja
Bhattadeva. ASI deciphered the inscriptions found there and discovered that the names of
various places mentioned here are Kaushami, Mathura, Pavata (Parvata), Vejabharada and
Sapatanaairikaa. An ASI team covered nearly 170 sq. km. falling in the area of the
Bandhavgarh Tiger Reserve over months-long exploration of the region which was
undertaken for the first time since 1938.

26 ancient temples/relics unravelled by ASI are of Kalachuri period which spans from the 9th
century CE to the 11th Century CE. Besides the 26 caves which date back from the 2nd to 5th
Centuries CE, archaeological remains of the Mahayana sect of Buddhism such as chaitya-
shaped doors and cells containing stone-beds have also been reported by the ASI team.
The monasteries, stupas, and 24 Brahmi inscriptions found by the ASI are also from the 2nd
Century CE to the 5th Century CE. 46 sculptures, 20 scattered remains and 19 water
structures date from the 2nd -15th Century CE. Among the 46 sculptures found by the ASI
there is a giant Varah sculpture which is one of the largest found by the agency.

The exploration was conducted by ASI’s Jabalpur circle. Being a tiger reserve, unrestricted
access to tourists to the archaeological sites is unlikely to be allowed. Bandhavgarh Forest
Reserve is best known for Evergreen Sal forest and Mixed forest. About 515 species of plants
are found there and it is also home to 242 species of birds and many species of reptile and
insects. The major mammal of Bandhavgarh is the Tiger. Apart from that, Leopard, Wild dog,
Wild cat, Hyena, Wolf, Chital, Sambar, Black Buck, etc., are easily seen there.

SubQuestion No : 53

Q.53 ‘Being a tiger reserve, unrestricted access to tourists to the archaeological sites is
unlikely to be allowed.’ This sentence means that the tourists:

Ans X A. will have access to neither to the tiger reserve nor to the archaeological sites.
< B. will have restricted access to the tiger reserve.
" C. will have restricted access to the archaeological sites.

< D. will be allowed to reach the archaeological finds freely.

Question ID : 8401606616

l Chosen Option : C

Status : Answered
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Comprehension:

Read the given passage and answer the questions that follow.

The Archaeological Survey of India (ASI) has cleared some stunning ancient remains in the
Bandhavgarh Forest Reserve. ASI exploration has recorded 26 temples, 26 caves, 2
monasteries, 2 stupas, 24 inscriptions, 46 sculptures, other scattered remains and 19 water
structures in Madhya Pradesh’s Tiger haven. These finding are from different historical time
zones and cover the reigns of the kings Shri Bhimsena, Maharaja Pothasiri, Maharaja
Bhattadeva. ASI deciphered the inscriptions found there and discovered that the names of
various places mentioned here are Kaushami, Mathura, Pavata (Parvata), Vejabharada and
Sapatanaairikaa. An ASI team covered nearly 170 sq. km. falling in the area of the
Bandhavgarh Tiger Reserve over months-long exploration of the region which was
undertaken for the first time since 1938.

26 ancient temples/relics unravelled by ASI are of Kalachuri period which spans from the 9th
century CE to the 11th Century CE. Besides the 26 caves which date back from the 2nd to 5th
Centuries CE, archaeological remains of the Mahayana sect of Buddhism such as chaitya-
shaped doors and cells containing stone-beds have also been reported by the ASI team.
The monasteries, stupas, and 24 Brahmi inscriptions found by the ASI are also from the 2nd
Century CE to the 5th Century CE. 46 sculptures, 20 scattered remains and 19 water
structures date from the 2nd -15th Century CE. Among the 46 sculptures found by the ASI
there is a giant Varah sculpture which is one of the largest found by the agency.

The exploration was conducted by ASI’s Jabalpur circle. Being a tiger reserve, unrestricted
access to tourists to the archaeological sites is unlikely to be allowed. Bandhavgarh Forest
Reserve is best known for Evergreen Sal forest and Mixed forest. About 515 species of plants
are found there and it is also home to 242 species of birds and many species of reptile and
insects. The major mammal of Bandhavgarh is the Tiger. Apart from that, Leopard, Wild dog,
Wild cat, Hyena, Wolf, Chital, Sambar, Black Buck, etc., are easily seen there.

SubQuestion No : 54

Q.54 Which of the following archaeological remains belong to the Mahayana sect of
Buddhism?

Ans X A. Statues
25 B. Ancient temples
4 C. Chaitya-shaped doors

25 D. Inscriptions

Status : Answered
l Chosen Option : C

Question ID : 8401606617
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Comprehension:
Read the given passage and answer the questions that follow.

The Archaeological Survey of India (ASI) has cleared some stunning ancient remains in the
Bandhavgarh Forest Reserve. ASI exploration has recorded 26 temples, 26 caves, 2
monasteries, 2 stupas, 24 inscriptions, 46 sculptures, other scattered remains and 19 water
structures in Madhya Pradesh’s Tiger haven. These finding are from different historical time
zones and cover the reigns of the kings Shri Bhimsena, Maharaja Pothasiri, Maharaja
Bhattadeva. ASI deciphered the inscriptions found there and discovered that the names of
various places mentioned here are Kaushami, Mathura, Pavata (Parvata), Vejabharada and
Sapatanaairikaa. An ASI team covered nearly 170 sq. km. falling in the area of the
Bandhavgarh Tiger Reserve over months-long exploration of the region which was
undertaken for the first time since 1938.

26 ancient temples/relics unravelled by ASI are of Kalachuri period which spans from the 9th
century CE to the 11th Century CE. Besides the 26 caves which date back from the 2nd to 5th
Centuries CE, archaeological remains of the Mahayana sect of Buddhism such as chaitya-
shaped doors and cells containing stone-beds have also been reported by the ASI team.
The monasteries, stupas, and 24 Brahmi inscriptions found by the ASI are also from the 2nd
Century CE to the 5th Century CE. 46 sculptures, 20 scattered remains and 19 water
structures date from the 2nd -15th Century CE. Among the 46 sculptures found by the ASI
there is a giant Varah sculpture which is one of the largest found by the agency.

The exploration was conducted by ASI’s Jabalpur circle. Being a tiger reserve, unrestricted
access to tourists to the archaeological sites is unlikely to be allowed. Bandhavgarh Forest
Reserve is best known for Evergreen Sal forest and Mixed forest. About 515 species of plants
are found there and it is also home to 242 species of birds and many species of reptile and
insects. The major mammal of Bandhavgarh is the Tiger. Apart from that, Leopard, Wild dog,
Wild cat, Hyena, Wolf, Chital, Sambar, Black Buck, etc., are easily seen there.

SubQuestion No : 55
Q.55 Which statement is NOT true according to the passage?
Ans ” A. This is the first exploration carried out by ASI in the Bandhavgarh region.

5 B. The 24 inscriptions found in the Bandhavgarh Tiger Reserve are in Brahmi script.

5 C. The ASI exploration covered nearly 170 sq. km. area of the Bandhavgarh Tiger
Reserve.

5 D. The finding date back to 2-11th Centuries CE and cover the reigns of many kings.

Question ID : 8401606618

Chosen Option : C

Status : Answered
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